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This document summarizes the differences between Cisco Network Planning Solution (Cisco NPS) 
Release 2.1 and Release 2.0.1. Release 2.1 is a full release that replaces existing 2.0 installations. If you 
are updating to Release 2.1, you should review this document.
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Installing Cisco Network Planning Solution 2.1

For detailed instructions on how to install the Release 2.1 software, refer to the 
instructions in the Installation Guide for Cisco Network Planning Solution. You 
can view an online version of this document at Cisco.com: 

http://www.cisco.com/en/US/products/ps6363/prod_installation_guides_list.html

WARNING—If you are using Release 1.1 software or earlier, you must update 
to Release 2.0 before you update to Release 2.1. For details on updating from 
Release 1.1, see the Installation Guide for Cisco Network Planning Solution for 
Release 2.0 at the above URL.

http://www.cisco.com/en/US/products/ps6363/prod_installation_guides_list.html
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Release 2.1 Description

Release 2.1 provides enhancements to the existing capabilities of 
Cisco Network Planning Solution. It also implements suggestions and fixes to 
software problems reported in earlier releases.

The following sections highlight the changes to 
Cisco Network Planning Solution that were introduced in Release 2.1.



Readme

Cisco Network Planning Solution/Release 2.1 3

Installation and License Enhancements

The following enhancements are available in 2.1:

• License File Format Change on page 3

• Installation Utility Change on page 3

• 64-Bit Graphical User Interface on page 4

• Migration of Preference Values on page 5

License File Format Change

The format of the license file has been changed to hold additional information 
about each license. This change has the following effects:

• The 2.1 license server automatically converts pre-2.1 license files to the new 
format when it reads them. A 2.1 license server can serve licenses to any 
release of Cisco Network Planning Solution.

• After a pre-2.1 license file has been converted, pre-2.1 license servers 
cannot use it and should be replaced with 2.1 license servers.

If you need to run a mix of 2.1 and pre-2.1 applications, install a 2.1 license 
server (using the “Floating—serve licenses from this computer” option) and 
configure the applications to contact it.

Installation Utility Change

Cisco Network Planning Solution is now installed using the InstallAnywhere 
installation technology, which provides a Java-based graphical installer.

Note—Because these installers use a different technology, they generally take 
longer and require slightly more disk space during installation than installers 
from previous releases. 
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64-Bit Graphical User Interface

Previously, only simulations run from the command-line could access the 
additional memory of 64-bit operating systems. Starting in 2.1, the 
Cisco Network Planning Solution GUI supports 64-bit operating systems. 
Therefore, if you have a 64-bit operating system, running a simulation or an 
analysis takes advantage of the 64-bit operating system memory.

Note— 
The 64-bit GUI is supported on Windows and Linux platforms only. 
The 64-bit GUI is not available for Cisco Application Analysis Solution 
functionality in Release 2.1.

For Windows: 
When Cisco Network Planning Solution is installed on a machine with a 64-bit 
operating system, the installation includes two shortcuts:

• Cisco Network Planning Solution 2.1

• Cisco Network Planning Solution 2.1 (64-bit)

Use the 64-bit shortcut to start Cisco Network Planning Solution and run using 
64-bit memory. Use the other shortcut to start Cisco Network Planning Solution 
and run using 32-bit memory. The 64-bit option can be more efficient and 
scalable for running a simulation or an analysis on large networks.

For Linux: 
When Cisco Network Planning Solution is installed on a machine with a 64-bit 
operating system, Cisco Network Planning Solution uses the 64-bit capability 
by default. For Cisco Network Planning Solution to use 32-bit, you must pass 
“-32bit” as a command-line argument. For example, to run a 32-bit simulation or 
analysis on a 64-bit machine, specify “cnps -32bit” on the command-line.

Additionally, note that the "GNU Libidn" library is required when running on the 
64-bit Red Hat Linux platform.
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Migration of Preference Values

When upgrading, your preference values are migrated to ensure a smooth 
transition.

The migration process occurs when Cisco Network Planning Solution is started 
for the first time. When the migration is complete, a dialog box informs you of 
the migration. Click the Show Details… button to view a detailed log of the 
migrated preferences. If the dialog box indicates, you may have to restart 
Cisco Network Planning Solution for the migrated preferences to become 
effective.

Note the following:

• The migration of preference values occurs when all of the following 
conditions are true:

— No preference file exists. (This is always true when 
Cisco Network Planning Solution is started for the first time after 
installation.)

— A previous release of Cisco Network Planning Solution is already 
installed.

• If more than one previous release is already installed, the migration process 
uses the most recent release.

• To bypass the migration process, use the “-skip_preferences_migration” 
command-line option when starting Cisco Network Planning Solution.
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Network Topology, Configuration, and Traffic Import 
Enhancements

The following enhancements are available in 2.1:

• Topology on page 6

• Traffic Center Enhancements on page 12

• Performance Metrics Import on page 13

• Configure Links Delays from Measured Delay Information on page 14

Topology

The following sections describe enhancements to the topology import features.

Import from Cisco Virtual Network Data Server

The following sections describe enhancements to the import from 
Cisco Virtual Network Data Server features.

Enhanced Support for Importing and Analyzing Cisco IOS XR Devices

Cisco NPS now supports version 3.4.1 of Cisco IOS XR. This change adds 
support for many of the new features that were added to Cisco IOS XR since 
version 3.2, which was the highest supported version of Cisco IOS XR in 
previous releases.

The Cisco IOS XR enhancements add support for the following:

• Routing protocols: BGP, ISIS, OSPF, RPL, static and utility routing

• MPLS: LDP, RSVP, traffic engineering, VPN

• Quality of service

• IP addressing and services: access lists, ARP, HSRP, network stack IPv4, 
prefix lists, VRRP

• System security: AAA

• System management: terminal services, SNMP, logging service
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Support for Importing and Analyzing Alcatel Service Provider Class Devices

Cisco NPS provides support for import from Cisco Virtual Network Data Server, 
Cisco NPS Flow Analysis, and Cisco NPS Network Validation for the following 
Alcatel-Lucent Service Provider class devices:

• 7750 Service Router 

• 7450 Ethernet Service Switch

Support is provided as follows:

• Addressing (all supported interface types) 

• ISIS 

• OSPF 

• BGP 

• Static Routing 

• MPLS-TE (RSVP, LDP) 

Import of Measured Performance Data

You can import measured performance data from your network devices into 
Cisco Network Planning Solution from Cisco Virtual Network Data Server 
during initial or incremental imports, as shown in Figure 1. This measured 
performance data (delay, jitter, and packet loss) is then available for use in 
performing flow analysis studies.The imported information is stored in the 
Performance Metrics attribute on the node.

Figure 1   Import Measured Data from Cisco Virtual Network Data Server

Enhanced Support for Forwarding Table Import

Support for the import of forwarding tables has been significantly enhanced for 
this release. Forwarding tables are now imported as part of the vne.xml file 
rather than as separate files, expanding support to any devices for which 
forwarding tables are collected in Cisco Virtual Network Data Server. You no 
longer have to select the “Include collected configuration files” checkbox to 
import the forwarding tables.

Select the Filters tab of the 
Import from 
Cisco Virtual Network Data 
Server dialog box. 

Choose All for Performance 
metrics to import the data.
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Additionally, support has been added for VPN routing and forwarding (VRF) 
tables, protocol tables, and VRF protocol tables. The following new command 
support has been added:

• Cisco

— show ip route vrf vrf

— show ip route vrf vrf protocol

— show ip route protocol

• Juniper

— show route (also shows VRF tables)

— show route protocol protocol
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eXpress Data Import

The following sections describe enhancements to the eXpress Data Import 
import features.

Import Assistant

The Unconnected Unnumbered tab of the Import Assistant dialog box has been 
enhanced, as shown in Figure 2. When you select an unconnected unnumbered 
interface from the left panel, available interfaces to which you can connect 
appear in the right panel. A new lower panel of the dialog box displays 
Connections Created, which you can browse, select, and disconnect.

Figure 2   import Assistant Dialog Box Enhancement

Use the Disconnect
button to clear selected
connections.

Select an interface, then choose from
the available peer interfaces. Click
Connect.

Connected interfaces then appear
below.
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Enhanced Support for Forwarding Table Import

Support for the import of forwarding tables has been significantly enhanced for 
this release. The following new command support has been added to let you 
import the VPN routing and forwarding (VRF) tables, protocol tables, and VRF 
protocol tables:

• Cisco

— show ip route vrf vrf

— show ip route vrf vrf protocol

— show ip route protocol

• Juniper

— show route (also shows VRF tables)

— show route protocol protocol

View Multiple Imported Forwarding Tables

When you import multiple forwarding tables, as described in Enhanced Support 
for Forwarding Table Import on page 7 and Enhanced Support for Forwarding 
Table Import on page 10, you can now select the forwarding table you want to 
see from the pop-up table, shown in Figure 3.

Figure 3   View Multiple Forwarding Tables

Clicking on any forwarding table lets you view more information for that 
forwarding table.
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Enhanced Support for Juniper

In this release, import support for Juniper devices was expanded. Support of 
certain features was enhanced, while other features were added. The following 
features are now supported in Cisco Network Planning Solution:

• OSPF Domain ID

• BGP AS Loop path check

• Simple filters

Existing support for Juniper devices in Cisco Network Planning Solution was 
enhanced for:

• BGP MED

• Static routes in routing tables
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Traffic Center Enhancements

You can now isolate Cisco Application Analysis Solution deployed flows in the 
traffic center and group by creation information, as shown in the following figure.

Figure 4   Cisco Application Analysis Solution to Flows in Traffic Center

In the Traffic Center, flows can 
be grouped according to how 
they were generated under the 
‘Creation Information’ 
arrange-by option.

In the case of 
Cisco Application Analysis Solut
ion-to-Flows derived traffic, a 
new attribute called ‘Deployment 
Data’ is used to create an 
additional subgroup.
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Performance Metrics Import

You can import measured performance data from your network devices into 
Cisco Network Planning Solution from text files, as shown in Figure 1. This 
measured performance data (delay, jitter, and packet loss) is then available for 
use in performing flow analysis studies.The imported information is stored in the 
Performance Metrics attribute on the node.

Figure 5   Import Performance Metrics
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Configure Links Delays from Measured Delay Information

A new Topology menu option lets you configure link delays based on the 
measured delay information you imported from 
Cisco Virtual Network Data Server or from text files. This new feature lets you 
analyze end-to-end delay in your network model based on real-world 
information rather than on distance-based algorithms. Use the menu option 
Topology > Configure Link Delays > From Measured Delay Information…, as 
shown in the following figure.

Figure 6   Configure Link Delays from Measured Delay Information
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Discrete Event Simulation Enhancements

The following discrete event simulation (DES) enhancements are available in 
2.1:

• Enhanced Support for Importing and Analyzing Cisco IOS XR Devices on 
page 15

• Module-Centric Reports on Global Packet Statistics on page 16

• HAIPE Model Enhancements on page 16

• Circuit-Switched Model No Longer Included in Model Library on page 16

• Global Packet Statistics on page 16

• Compilation Behavior on page 17

• Time-Precision Preference on page 18

• Compilation and Linking Preferences on page 18

Note—Cisco Advanced Capture Module is needed to use the discrete event 
simulation features in Cisco NPS.

Enhanced Support for Importing and Analyzing Cisco IOS XR Devices

Cisco NPS now supports version 3.4.1 of Cisco IOS XR. This change adds 
support for many of the new features that were added to Cisco IOS XR since 
version 3.2, which was the highest supported version of Cisco IOS XR in 
previous releases.

The Cisco IOS XR enhancements add support for the following:

• Routing protocols: BGP, ISIS, OSPF, RPL, and static routing

• MPLS: LDP, RSVP, traffic engineering, VPN

• Quality of service

• IP addressing and services: access lists, ARP, HSRP, network stack IPv4, 
prefix lists
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Module-Centric Reports on Global Packet Statistics

The global packet statistics feature now has module-centric views in addition to 
the original node-centric views. The module-centric approach is useful for 
performing packet throughput analysis of a simulation. With it, you can easily 
determine which module is dropping the most packets, then examine the nodes 
containing a given module to see which ones are major contributors to the 
problem.

HAIPE Model Enhancements

The HAIPE (High Assurance Internet Protocol Encryptor) model has been 
enhanced to support the following:

• Dynamic security associations using HAIPE IKE

• Orphan SA Recovery using HAIPE IKE

• Transport mode transforms

• SA based statistics (provides the ability to view statistics on a per-SA basis 
and at the node level

• Ability to configure a security association to be used by multiple security 
policies 

• Ability to configure a manual peer enclave prefix table entry using the peer 
HAIPE device's name rather than the CT (cipher text) IP address. As part of 
this enhancement, the HAIPE Parameters > Manual Peer Enclave Prefix 
Table (PEPT) > Peer CT Address attribute has been replaced by the HAIPE 
Parameters > Manual Peer Enclave Prefix Table (PEPT) > Peer HAIPE.

Circuit-Switched Model No Longer Included in Model Library

The circuit-switched model is no longer shipped as part of the model library. 
Although it is no longer maintained or supported, the model can be obtained 
from the Cisco Technical Assistance Center.

Global Packet Statistics

Global packet statistics represent an expansion of the Packet Info report 
formerly available in the simulation console and DES log. These statistics 
provide a “high-level” view of simulation behavior, letting you quickly get a sense 
of whether a simulation is performing as expected. You can use this information 
as a first step in debugging a model.

The global packet statistics feature introduces the following changes to the 
Packet Info report:

• The number of packets created, copied, and destroyed during the simulation 
are reported per packet format and per node.
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• The checkbox used to control collection of these statistics has moved from 
the Execution > Advanced > Kernel Reports page of the Configure/Run DES 
dialog box to the new Outputs > Global Packet Statistics page.

• Statistic collection is enabled by default (but continues to be available only 
for sequential development kernels).

• The collected statistics are saved in an output table file with a name of the 
form <project_name>-<scenario_name>-DES-<run_number>.ot.

• The collected statistics can be viewed in the Results Browser under a tab 
corresponding to the output file name; for example, 
“DES Run (<run_number>) Tables”.

Figure 1   Packet Statistics in Results Browser

Note—When the Packet Data Sharing Mode (sim_packet_sharing) preference 
is set to conservative or full, the content of “copied” packets is shared unless 
changes are needed. Regardless of this preference, the packet statistics count 
all packets that were copied or destroyed, as well as those that would have been 
copied or destroyed if the packet sharing optimization was disabled.

Compilation Behavior

When preparing for a discrete event simulation, 
Cisco Network Planning Solution programs that compile files (such as 
op_mkso, op_mksim, and op_runsim) now systematically keep compiling files 
instead of stopping at the first error. You can kill the build process if needed; 
otherwise, all of the specified models are compiled to provide a general report 
of missing models, conflicting models, and so on.
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Time-Precision Preference

The following DES-related preference has been added:

• log_time_precision—Specifies the number of decimal places recorded for 
simulation times in the DES log (the default is 12).

Compilation and Linking Preferences

New preferences let you define flags and libraries specific to 32-bit and 64-bit 
architectures. These preferences are:

• comp_flags_32bit

• bind_shobj_flags_32bit

• bind_shobj_flags_64bit

• bind_shobj_libs_32bit

• bind_shobj_libs_64bit

• bind_static_flags_32bit

• bind_static_flags_64bit

• bind_static_libs_32bit

• bind_static_libs_64bit
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Cisco NPS Flow Analysis Enhancements

The following enhancements are available in 2.1:

• Measured Performance Data Analysis on page 20

• New Method for Viewing the Routes Computed for Demands on page 22

• Enhanced Support for Importing and Analyzing Cisco IOS XR Devices on 
page 23

• Support for Importing and Analyzing Alcatel Service Provider Class Devices 
on page 23

• Support for Firewall Services Module on page 24

• Enhanced Support for Imported Forwarding Tables on page 24

• Enhanced Support for Juniper on page 24
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Measured Performance Data Analysis

The Configure/Run Cisco NPS Flow Analysis dialog box has been enhanced to 
let you use measured performance data to do end-to-end performance analysis 
in your network model. You can import the data from either 
Cisco Virtual Network Data Server or text files. A new Performance Metrics tab 
appears in the Configure/Run Cisco NPS Flow Analysis dialog box, as shown in 
the following figure.

Figure 1   Performance Metrics Tab in Flow Analysis
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After running a flow analysis using the measured data, you can view the 
Performance Demand Routing Report, shown in Figure 2, to see the specific 
delay information: average delay, end-to-end jitter, and maximum packet loss. 
For each route entry, you can see the detail of delay for all hops, defined by 
propagation, transmission, and queueing delays. The report shown here 
includes transmission and queuing delays imported from the operational 
network. 

Figure 2   Performance Demand Routing Report - With Measured Performance Data
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New Method for Viewing the Routes Computed for Demands

It is now easier to view the routes that were computed for a demand during a 
flow analysis. After running a flow analysis, you can display the routes for a 
demand in the Project Editor workspace. To do this, right-click on the demand 
(in the workspace or in the Network Browser) and select Show Routes (Flow 
Analysis) from the pop-up menu. This operation displays the route in the 
workspace and in the Network Showcase, as shown in the following figure.

Figure 3   Viewing the Routes for a Demand After a Flow Analysis

The route for this demand is 
shown in yellow here (left) and in 
the Network Showcase (below).
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Enhanced Support for Importing and Analyzing Cisco IOS XR Devices

Cisco Network Planning Solution now supports version 3.4.1 of Cisco IOS XR. 
This change adds support for many of the new features that were added to 
Cisco IOS XR since version 3.2, which was the highest supported version of 
Cisco IOS XR in previous releases.

The Cisco IOS XR enhancements add support for the following:

• Routing protocols: BGP, ISIS, OSPF, RPL, static and utility routing

• MPLS: LDP, RSVP, traffic engineering, VPN

• Quality of service

• IP addressing and services: access lists, ARP, HSRP, network stack IPv4, 
prefix lists, VRRP

• System security: AAA

• System management: terminal services, SNMP, logging service

Support for Importing and Analyzing Alcatel Service Provider Class Devices

Cisco Network Planning Solution provides support for import from 
Cisco Virtual Network Data Server, Cisco NPS Flow Analysis, and 
Cisco NPS Network Validation for the following Alcatel-Lucent Service Provider 
class devices:

• 7750 Service Router 

• 7450 Ethernet Service Switch

Support is provided as follows:

• Addressing (all supported interface types) 

• ISIS 

• OSPF 

• BGP 

• Static Routing 

• MPLS-TE (RSVP, LDP) 
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Support for Firewall Services Module

You can now perform a flow analysis that includes Cisco Firewall Services 
Modules (FWSM) in your Cisco 6500 Catalyst switches. Currently, support is 
limited to single-context Cisco FWSM.

Enhanced Support for Imported Forwarding Tables

Flow analysis can now use protocol tables (forwarding tables that have been 
filtered by protocol) from an operational network. No configuration changes are 
needed to use forwarding tables from an operational network in a flow 
analysis—the same procedure is used whether you are using the full IP 
forwarding table or protocol tables.

For information on importing these types of forwarding tables, see Enhanced 
Support for Forwarding Table Import on page 10.

Enhanced Support for Juniper

In this release, Cisco NPS Flow Analysis support for Juniper devices was 
expanded. Support of certain features was enhanced, while other features were 
added. The following features are now supported in 
Cisco Network Planning Solution:

• OSPF Domain ID

• BGP AS Loop path check

• Simple filters

Existing support for Juniper devices in Cisco Network Planning Solution was 
enhanced for:

• BGP MED
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Cisco NPS Network Validation Enhancements

The following enhancements are available in 2.1:

• Reporting on page 25

• Rule Enhancements on page 28

• Rule Development and API Enhancements on page 31

Reporting

The following reporting enhancements are available in this release:

• Scoring on page 25

• Device Configuration File Validation Reporting on page 26

• Verifying Identical Configurations on Multiple Devices on page 26

Scoring

Scores can now help you evaluate the results of your network analysis, as 
shown in Figure 1. The scores are available for the following:

• Report—average of all device scores in the report

• Rules—a single score for each rule run in the analysis

• Devices—a weighted average of the scores given by each rule in the 
analysis

Figure 1   Report Score in Executive Summary

The report score is 90.1.

When report comparison is enabled, 
you can view the difference between 
the current report and a previously 
generated report.
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Device Configuration File Validation Reporting

Reporting for device configuration file validation is enhanced significantly to 
include the following:

• New tabular reporting

• Hierarchical presentation of violations

• Separate entries for match/no match commands

• Parametric control of table columns

The following figure shows an example of the new tabular format.

Figure 2   New Device File Configuration Validation Tabular Format

Verifying Identical Configurations on Multiple Devices

The Organizational Policies rule suite provides the following new rules that 
report on problems with sections of device configuration files that should be 
configured identically for a specified set of devices:

• Verify Identical Configuration Sections—reports the specified sections of 
the configuration files that are not configured identically for a device group. 
The following figure shows the verification rules by supported vendor in the 
Organizational Policies rules suite.
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Figure 3   Verify Identical Configuration Rules

• Mismatched Configuration Sections—reports the identical and differing 
sections for all the specified configuration sections for the device group. 
When this rule runs along with the verification rule, you can pinpoint the 
configuration inconsistencies on the devices in the group. The following 
figure shows the rules by supported vendor in the Organizational Policies 
rules suite.

Figure 4   Mismatched Configuration Sections Rules

For more information, see Verifying Identical Configurations on Multiple Devices 
on page 57.
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Rule Enhancements

The following rule support has been added or modified:

• Security Compliance on page 28

• Alcatel Enterprise-Class Devices on page 29 

• Cisco IOS XR on page 30

• NetScreen Firewalls on page 31

Security Compliance

The following rules provide enhanced or new rule support for security 
compliance:

• Administration

— Verify Well-Known Passwords Not Used for Telnet Access

— Verify OS Images

— Verify Device OS Version (enhanced)

• AAA

— Flood Guard Disabled

• Firewalls

— Verify Fragmented Packets Not Allowed

— Verify Timeout for Connection Timers

— Verify Fixup Protocols

— Anti-Spoofing Disabled on Interfaces (enhanced)

— TCP Intercept Enabled on CBAC Enabled Interfaces

— Verify CBAC Rules

— Verify CBAC Settings

— Verify Destinations Permitted by TCP Intercept

— Verify Object Groups

— Verify TCP Intercept Settings

• IPSec

— Verify IKE Phase 1 Settings

— Verify ISAKMP Identity

— IKE Disabled
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• IP Routing

— SPD Disabled

— Cisco Express Forwarding Not Enabled

— Verify Scheduler Interval

— Verify Scheduler Allocate

— NetFlow Not Enabled

• QoS

— Verify Committed Access Rate

• Route Maps and ACLs

— Verify Access Control Lists (enhanced)

— Verify Denied Source Addresses in Inbound Extended ACLs

— Verify Explicit Deny Any in Extended ACLs

— Verify ICMP Message Filters

— Verify Inbound Traceroutes Denied

— Verify Permitted Destinations in Inbound Established TCP Connections

— Verify Permitted Source Addresses In Extended ACLs

Alcatel Enterprise-Class Devices

Organizational Policies

The following new rules provide support for Alcatel Enterprise-Class device 
configurations:

• Organizational Policies

— Alcatel AOS Configuration Differs from Template File

— Alcatel AOS Configuration Differs from Specified Commands

— Alcatel AOS-W Configuration Differs from Template File

— Alcatel AOS-W Configuration Differs from Specified Commands

— Alcatel OmniStack OS Configuration Differs from Template File

— Alcatel OmniStack OS Configuration Differs from Specified Commands

VRRP and Wireless LAN

The following new rules by rule suite integrate the Alcatel VRRP and Wireless 
LAN rules:
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• VRRP

— Duplicate Virtual Router ID

— Ineffective Priority Difference

— Insufficient Number of Routers

— Mismatched Advertisement Interval

— Mismatched Virtual IP Addresses 

• Wireless LAN

— Duplicate Access Point Location

— Verify Access Point Encryption Mode

— Verify Access Point Maximum Clients Limit

— Verify SSID Broadcast Status

Cisco IOS XR

The following new rules provide support for version 3.4.1 of Cisco IOS XR.

• BGP

— Router Configuration References Undefined Route Policy

• IS-IS

— Redistribution References Undefined Route Policy

• Organizational Policies

— Cisco IOS XR Configuration Differs from Template File

— Cisco IOS XR Configuration Differs from Specified Commands

• OSPF

— Redistribution References Undefined Route Policy

For more information about Cisco IOS XR support, see Enhanced Support for 
Importing and Analyzing Cisco IOS XR Devices on page 6.
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NetScreen Firewalls

The following new rules support NetScreen Firewall devices:

• Organizational Policies

— Juniper ScreenOS Configuration Differs from Template File

— Juniper ScreenOS Configuration Differs from Specified Commands

• Policy-Based Routing (New Suite)

— Policy References Undefined Match Group

— Policy References Undefined Action Group

— Match Group References Undefined Extended ACL

— Zone References Undefined Policy

— Virtual Router References Undefined Policy

— Interface References Undefined Policy

Rule Development and API Enhancements

The following rule development and API enhancements have been added:

• Cisco IOS XR Route Policy (RPL) API on page 31

• IP Forwarding Table API on page 32

Cisco IOS XR Route Policy (RPL) API

The following new functions and an enumeration have been added to support 
the IOS XR Route Policy Language (RPL) API:

New functions:

• Ip.init_rpl_parser ()

• Ip.get_rpl_route_policies ()

• Ip.get_rpl_community_sets ()

• Ip.get_rpl_route_policy_info ()

New enumeration:

• Ip.Route_Policy_Information_Type Class
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IP Forwarding Table API

The following two enumerators have been added to the IP forwarding table API:

• Ip.Route_Entry_Metric Class

• Ip.Route_Entry_Preference_Class



Readme

Cisco Network Planning Solution/Release 2.1 33

Planning and Design Enhancements

The following enhancements are available in 2.1:

• New Design Action: IGP Metric Configuration on page 33

• New Design Action: IGP Metric Optimization on page 34

New Design Action: IGP Metric Configuration

This ipg_metric_configuration design action configures OSPF or IS-IS 
interfaces, based on one of the following properties:

• Physical length of the connected link

• Propagation delay between the two interfaces (specified by the “delay” 
attribute on the connected link)

Each IGP interface has a “metric” attribute that determines how likely traffic 
demands will use that interface when routing traffic: the higher the metric, the 
more likely that demands will avoid that interface. The objective is to configure 
the IGP interface metrics so that demands follow their mean shortest path—that 
is, to follow a route that has the minimum overall propagation delay.
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New Design Action: IGP Metric Optimization

The igp_metric_optimization design action is used to perform traffic engineering 
by optimizing the IGP interface metrics. IGP metrics are most commonly defined 
by default settings, which often results in overutilized links. You can use 
igp_metric_optimization to configure IGP metrics so that individual links do not 
get overutilized.

Given current traffic demands and a maximum link utilization threshold, this 
design action works to configure the IGP interface metrics to handle the current 
traffic and ensure that utilization on any individual link does not exceed the 
specified threshold. Three modes of operation are supported:

• Inspect—Analyze the current network, then generate reports that describe 
the quality of the current solution and any violations of the specified 
requirements.

• Repair—Apply the optimization algorithm to produce a solution that satisfies 
the specified requirements. 

• Optimize—Apply the optimization algorithm to improve the current solution 
for minimizing maximum link utilization (assuming that the current solution 
satisfies all requirements).
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General Model Enhancements

The following enhancement is available in 2.1:

• Alcatel Enterprise-Class Device Support on page 35

• Forwarding Table Comparison Enhancement on page 35

Alcatel Enterprise-Class Device Support

This release adds support for import of Alcatel enterprise-class devices from 
Cisco Virtual Network Data Server. The devices specifically supported include

• OmniSwitch 6600-9800 Series

• OmniAccess 4000 and 6000 Series

• OmniStack LS 6200 Series

Device information is collected on Cisco Virtual Network Data Server by the 
adapters Device Config File Collection and Device Config File Import.

Forwarding Table Comparison Enhancement

The Forwarding Table Comparison feature has been enhanced to support 
protocol tables (forwarding tables that have been filtered by protocol) from an 
operational network. No configuration changes are needed when using these 
types of forwarding tables—the same procedure is used whether you are using 
the full IP forwarding table or protocol tables.

For information on importing these types of forwarding tables, see Enhanced 
Support for Forwarding Table Import on page 10.
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General GUI Enhancements

The following enhancements are available in 2.1:

• Visualization Enhancement on page 36

• Treeview Enhancements on page 36

Visualization Enhancement

The GUI now supports anti-aliasing, which softens edges, thus providing a 
smoother and sharper look.

Treeview Enhancements

Treeviews have been enhanced with new functionality and an updated look. 
The treeview enhancements include the following features:

• Keyboard Shortcuts for Treeviews

Use the following shortcut keys to quickly navigate through a treeview.

• Type Ahead Searching—You can now easily locate items in a treeview by 
typing the first one or more characters of the name. Type ahead searching 
starts with the selected item. If you repeat the same characters, the search 
cycles through the treeview. Note that the type ahead searching feature 
considers displayed (non-hidden) items only.

• Treeview Appearance—The enhanced treeviews have an updated 
three-dimensional look. Additionally, there are new preferences to define the 
font and the lines between treeview nodes.

— treeview_font—Specifies the default font used for treeviews.

— treeview_connector_style—Specifies the line style used in a treeview to 
show connections between nodes. Select from Dotted Lines, Solid Lines, 
or No Lines.

Shortcut Key Description

+ (plus) Expands a treeview node.

- (minus) Collapses a treeview node.

<Right Arrow> Expands the treeview node and selects the first child node.

<Left Arrow> Collapses the treeview node and selects the parent node.

<Backspace> Selects the parent node
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Project Editor Enhancements

The following enhancements are available in 2.1:

• Easier Statistic Selection in Results Browser on page 37

• Network Difference Reporting on page 38

• Edit Attribute Dialog Box Enhancements on page 39

• Enhanced Usability of Compound Attribute Table Dialog Box on page 40

• Subnet Enhancements on page 40

• Logical Object Selection Enhancements on page 41

• Zooming/Panning Enhancements on page 41

• Map Improvements on page 42

• Embedded Bird’s-eye Viewer on page 43

• Toggle Display of Links on page 43

Easier Statistic Selection in Results Browser

You now can change the order in which results are listed in the results treeview 
of graph and parametric studies pages in the Results Browser. This lets you 
arrange the tree to group results by their parent objects, by name, by specific 
tags (which identify related statistics), or any other way that provides convenient 
access to the results in which you are interested. These arrangements can be 
saved and reused.
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Network Difference Reporting

Configuring Network Difference Reports

Network Difference reports are now configured using the following two new 
options in the Configure/Run Network Differences dialog box:

• Previous version of the current open scenario—select this option when 
you want to compare one scenario to the next.

• [Scenario base name](latest version)—select this option when you want to 
compare the current scenario to another changing scenario or to a “gold 
standard” scenario.

Note—If you have an Automation license, you no longer need to configure a 
separate dialog box for automation tasks. After you click the automation task 
button Configure/Run Network Differences dialog box, you can save the current 
settings as a file for automation.

Network Difference Reporting Enhancements

The following areas of network difference reporting have been added or 
enhanced:

• Administration - IP Interfaces

• Hardware Modules

• HSRP

• Route Maps and ACLs
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Edit Attribute Dialog Box Enhancements

The Edit Attribute dialog box enhancements are:

• Filtered Search Feature on page 39

• Display of Compound Attributes on page 39

Filtered Search Feature

The search feature on the Edit Attributes dialog box has been enhanced so that 
you can more easily locate attributes. In previous releases, the search feature 
cycled through the Edit Attributes dialog box with the next attribute or value that 
matched the search criteria. In release 2.1, the search feature filters the attribute 
display.

When performing a filtered search from the Edit Attributes (Advanced) dialog 
box, you can specify whether filter criteria is a substring, an exact match, or a 
regular expression. Additionally, you can filter more precisely by specifying the 
items to compare against the filter criteria. Choose from attribute name, value, 
possible value (a value that you can choose from a pull-down menu), or tag. (A 
tag is a keyword that is associated with a model attribute, such as an interface 
type, vendor, or CLI command.)The results of a filtered search include built-in, 
hierarchical, and matching attributes/values.

Display of Compound Attributes

To make the display of compound attributes more friendly, the “row” attribute 
has been changed to “Number of Rows”. Additionally, when a compound 
attribute is collapsed, the defined values no longer appear in the values column. 
Instead, you can view the defined values in a tooltip by holding the mouse 
pointer over “…” in the Value column.

Figure 1   Compound Attribute Display in Attributes Dialog Box
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Enhanced Usability of Compound Attribute Table Dialog Box

The Compound Attribute Table dialog box has been enhanced with the following 
new features:

• Row Number Display—In previous releases, the row number column would 
slide out of view as you moved the slider to view columns. In 2.1, when the 
new “Show row labels” checkbox is selected, the row number column is 
frozen as you move the slider bar to view additional columns.

• Column Sorting—You can sort the table by a column by clicking the column 
header. Click the column header again to reverse the sort order. Click the 
column header a third time to turn off the sort feature.

Subnet Enhancements

The following functionality and behavior enhancements have been made to 
subnets:

• Create Subnets—In addition to creating subnets from the Object Palette, 
you can now quickly and easily create subnets from the Topology menu.

For more information, see Creating a Subnetwork from the Topology Menu.

• Create and Populate Geographic Subnets—The “Create and Populate 
Geographic Subnets” feature allows you to quickly create and populate 
subnets at specific geographic locations. This feature uses the 
latitude/longitude information stored in the default maps to create a tree of 
geographic regions (i.e., continents, countries, states/provinces, and cities).

The “Create and Populate Geographic Subnets” feature is especially useful 
when you want to organize a large set of imported nodes into a geographic 
subnet hierarchy. After creating and populating the geographic subnets, you 
can save the subnet hierarchy to a model assistant file that can be re-applied 
the next time the nodes are imported.

For more information, see Creating and Populating Geographic Subnets.

• Cut, Copy, and Delete Links connected to Nodes in Other 
Subnets—You can now cut, copy, and delete links that are attached to 
nodes in another subnet. However, before performing a cut, copy, or delete 
operation, be sure to select only the links on which you want to perform the 
operation.
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Logical Object Selection Enhancements

The Logical Object Selection dialog box has been replaced by a new user 
interface and functionality. The new Define Selection dialog box enables you to:

• Find/select objects based on object type (such as mobile nodes or duplex 
links)

• Find/select objects that contain specific attributes (simple, top-level, or 
nested)

• Find/select objects based on specific attribute settings

— String-based criteria include "Contains sub-string", "Matches string", and 
"Matches regular expression"

— Numerical criteria include "=", "!=", "<", "<=", ">", and ">="

• Combine search criteria using AND, OR, and NOT operators

• Create composite search definitions based on previously defined definitions

• Categorize and save, and re-use search definition files for object searches 
and User-Defined Reports.

The new functionality provides much better support for nested attributes. You 
can create search definitions based on any attribute, in any network object in a 
scenario.

Zooming/Panning Enhancements

Zooming and panning in the Project Editor have been greatly enhanced.

• Zooming can now be performed with the scroll wheel on your mouse:

— To zoom in, turn the scroll wheel forward or use the Page Down button.

— To zoom out, push the scroll wheel backward or use the Page Up button.

• Panning can now be performed with the scroll wheel on your mouse

— To pan, hold down the scroll wheel and drag the mouse pointer. 
Optionally, hold down the right and left mouse buttons and drag the 
mouse pointer.

Note that in previous releases, using the scroll wheel on your mouse moved the 
view up/down. In 2.1, to move the view up/down, hold down the Control key and 
turn the scroll wheel.
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Map Improvements

The background maps have been replaced with maps that are easier to view, 
display more information, and include additional behavior.

• The default map colors have been changed to maximize visualization of 
objects and to be more aesthetically pleasing.

• Maps now display cities by population.

The following preferences define the appearance of the new maps:

— network_world_map.default_cities_style—Specifies the cities (by 
population size) to display on background maps.

— network_world_map.default_ocean_style—Specifies whether to display 
bodies of water in blue on background maps.

— network_world_map.default_region_style—Specifies whether to display 
land (with country, state, province borders) on background maps.

• Because the new maps replace old maps, some of the old maps are 
deprecated. The maps that are deprecated are the border maps (also known 
as the CDS maps) and a subset of the MIF maps. The deprecated MIF maps 
are: asia, australia, canada, europe, france, germany, italy, japan, mexico, 
ocean_background, south_korea, usa, world, and world_bright.

The following preferences control the migration from the old deprecated 
maps to the new maps.

— network_world_map.deprecated_border_map_behavior—Specifies 
whether to suppress deprecated border maps in subnets.

— network_world_map.deprecated_mif_map_behavior—Specifies 
whether to show deprecated MIP maps in subnets.

— network_world_map.update_behavior—Specifies whether to replace 
deprecated maps with new maps. Replaced maps are retained, but they 
are not displayed.
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Embedded Bird’s-eye Viewer

The Bird’s-eye Viewer is now embedded in the Project Editor workspace. An 
embedded viewer is easier to use than the floating viewer.

To toggle the display of the embedded bird’s-eye viewer, click the Embedded 
Bird’s-eye Viewer button. The button is located in the lower-right corner of the 
Project Editor, as shown in the following figure.

Figure 2   Embedded Bird’s-eye Viewer

The embedded bird’s-eye view includes the same functionality as the bird’s-eye 
view displayed from the View menu. Use the Bird’s-eye Viewer to zoom, pan, 
and locate items of interest.

Toggle Display of Links

Frequently, after an import, there is a need to move nodes/subnets in the 
workspace. However, if there are numerous links, the links may interfere with 
the dragging and repositioning of the network objects.

Starting in release 2.1, you can toggle the display of links in the Project Editor. 
When links are hidden, it is much easier to reposition nodes/subnets. When 
satisfied with the node layout, you can show the links.

• To hide the links, choose View > Links > Hide All

• To display the links, choose View > Links > Show All

Hiding and showing links does not change the link bundling display or settings.

When links are hidden, links are not listed in the Network Browser (unless you 
choose to display hidden objects), and links do not display in the Bird’s-eye 
view. However, links do display in the Network Showcase between featured 
network objects.

Click the Embedded Bird’s-eye Viewer 
button to toggle the display of the 
Embedded Bird’s-eye Viewer
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Resolved Problems

Release 2.1 includes enhancements that address the following software 
problem reports (SPRs) from previous releases:

Table 1   SPRs Fixed in Cisco NPS Release 2.1 

SPR ID Problem Description

102178 Some Cisco NPS Network Validation rules generate a large number of Report 
Entries by default that may cause software to run out of memory.

102111 LACP (PAgP) should not disable port-group ports in Cisco switches, even 
though they could not be aggregated, if the port and its peer are in passive 
(auto) mode.

101016 Need support for match “as-path” option on Juniper policy configurations.

99741 Model difference report does not work for models derived from derived models, 
works for models derived from base models.

99012 Worst Case Failures table in Survivability Analysis report does not display 
correctly.

98399 Incorrect traceroute output in Virtual CLI.

98134 Discrete event simulation abort when trying to access many simulation 
attributes.

97580 Cannot specify months as units when importing and exporting traffic from/to 
spreadsheets.

93168 Traffic Center: The IP address displayed for an unmapped flow may be 
incorrect.

92943 When exporting graph data to spreadsheet, you cannot export more than 12 
digits after the decimal.

87898 When there are two ospf processes on Juniper routers, import assigns a 
process tag of 1 to both processes.

83680 Importing baseline load is slow for large networks.

End of Table 1
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Known Issues

This release contains the known issues listed in Table 2. 

Table 2   Known Issues in Cisco NPS Release 2.1 

SPR ID Problem Description

105903 Unable to run the product on Solaris machines that do not have libgcc. 

106276 Remedy Web Service Notification plugin generates an error message when the 
test notification is created on Linux (32- and 64-bit) and Solaris, but the remedy 
ticket is created.

101786 IPv6 readiness assessment may cause a program abort if the collating results 
phase requires more than 1.2GB of memory.

105925 Importing live nGenius data is not supported on 64-bit platforms.

106053 Cannot import data from Cisco VNDS when VND Server is running in “secure” 
mode.

88050 Cisco NPS Network Validation may run out of memory on very large networks 
when using IP forwarding tables and when a large number of issues are found.

99495 Intermittent program abort while adding directory in the Traffic Flow Import 
dialog box.

107232 Cisco Application Analysis Solution traffic is not supported in 64-bit discrete 
event simulation.

End of Table 2
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